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Abstract 
This document introduces the Microsoft Excel 2003 spreadsheet package. It 
aims to provide a quick start for new users. For more information on Microsoft 
Excel 2003 please refer to ‘Software made Simple Guide to Microsoft Excel 
2003’. Copies of the Guide are available to students and staff of Birkbeck 
either in paper form from CCS Help Desk, MB 151 or from the College 
Intranet at http://intra.bbk.ac.uk/ccs/docs/sms/. Help Desk is open on 
weekdays 10.00am - 8.00pm in term time, and in vacations it is open on 
weekdays 10.00am - 6.00pm. 
 
Prerequisites 
These notes assume that you are familiar with using a mouse and keyboard 
and a Windows desktop and that you can log in to CCS workstations and use 
a web browser. You should also be familiar with using on-line Help for 
Windows. If you are not familiar with these topics please refer to CCS 
document 3.38 ‘Getting Started on CCS Workstations’
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About this Document 

 Section numbers in brackets refer to section numbers in Software Made 
Simple – a Guide to Excel 2003 e.g. (SMS section 2.4).  

 Words that you type or choose are in bold type, e.g. Choose Programs 
from the Start menu. 

 Keys that you press are shown in small capitals e.g. press ALT. 
 Press KEY1 + KEY2 means press both keys together e.g. press CTRL + Z 
 Press KEY1, KEY2 means press each key consecutively e.g. press A, B. 
 Exercises for you to practice as you work through the notes are labelled 

Exercise, e.g. Exercise 1 Importing Database Objects. The steps that 
you do to complete the exercise are marked by round bullets (•). 

 Hints and tips are indicated by  If you are not very familiar with using 
computers then you should pay particular attention to the hints and tips. 
Even if you are fairly familiar with using a computer you should read them, 
as they can provide explanations of why you do something, or they may 
suggest an alternative way of doing things. 
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1 Introduction 
The aim of this workshop is provide the basic information on Excel so that by 
the end of the session you should be able to: 

 enter data into the spreadsheet 
 use it to calculate mean values 
 plot two simple graphs using Excel. 

 
Microsoft Excel 2003 has many powerful features for handling numeric 
problems. This workshop is to get you started using Microsoft Excel 2003 and 
will not attempt to cover the complex mathematics required to make full use of 
all the functions. However, each function is explained in the online help, so 
once you have learnt the basic skills you should be able to find out about your 
own particular interests. 
 
Microsoft Excel 2003 is a spreadsheet program. A spreadsheet is a powerful 
application for handling data, mostly numeric data. It is rather like an 
electronic ledger, which provides a method by which data can be analysed 
and used in complex calculations. However, do not worry – Microsoft Excel 
2003 performs the calculations for you.  

2 Getting Started 

2.1 Logging in 
If you are attending a  class at Birkbeck in a CCS workstation room then you 
will need to log in. If you are using your own computer then you should start 
the computer in the usual way and skip Exercise 1.  
 
You will need a username and password for access to Birkbeck Academic 
networked Workstations. If you are attending a workshop and your username 
and password are not available then the session leader will lend you one for 
the duration of the session. 

Exercise 1 Log in to a CCS workstation 
 
• At the Windows log in prompt, type your username in the 'Username' box. 
• Press the TAB key to move to the 'Password' box, and type your 

password. Then press the Enter key or click on O.K. Wait a few seconds 
while Windows checks your username and password, and allocates your 
network resources. 
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2.2 Downloading the sample data 
To save time a sample file birds.xls has been created for you and saved on a 
CCS Web page. You can download and save it using a web browser. In the 
next exercise we’ll use Internet Explorer but if you prefer to use another 
browser you should follow the instructions given with your browser. If you are 
using a CCS workstation then you should save your file in N:\My Documents. 
Otherwise you should save it to the location that you normally use for saving 
files. 
 

Exercise 2 Download and save the file 
• Start the Internet Explorer. You can click on the Internet 

Explorer icon on the task bar at the bottom of the screen or 
double click on the icon on the desk top.   

• Click in the box at the top of the screen labelled Address and 
type the URL (web address) 
http://www.bbk.ac.uk/ccs/docs/samples/birds.xls  

• When the File Download  box appears (Figure 1) click on Save 
 

Figure 1 Save a downloaded file 
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• On CCS workstations make sure that you’re My Documents folder is 
selected (Figure 2). Click on the My Documents icon if it is not.  
Otherwise select the location where you want to save the file. 

 
Figure 2 My Documents 

 

 
 
• Type the name of the file mybirds.xls in the box labelled File Name. Note 

that there is no space in the filename. Although most Windows systems 
will accept spaces it is best to avoid them as some computer systems do 
not recognise them. 

• Click on the button labelled Save.  
 

2.3 Starting Excel 

Exercise 3 Starting Excel 
• Click on the Start button on the taskbar at the bottom of the screen. The 

Start Menu will appear. 
• Click on Excel 2003 in the Microsoft Office 2003 group on the Start Menu. 

Excel 2003 will then start. If the Adobe Acrobat tool bar appears you may 
wish to hide it by clicking on the close button (Figure 3) 

• From the file menu chose Open and open your file mybirds.xls On CCS 
student workstations Excel  should look in N:\My Documents first. 
Otherwise you will have to browse for your file  

 
The Excel window is shown in Figure 3 (see next page). You may like to 
bookmark this diagram for future reference. If you have used Microsoft Word 
for Windows you will see many similarities between the applications, for 
example, some of the menus and toolbar buttons will be familiar. 
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The Microsoft Excel 2003 document is called a workbook. Each workbook 
consists of a number of worksheets. Each worksheet consists of a number of 
columns and rows of cells. The columns are identified by letters and the rows 
by numbers. Therefore any cell within the grid can be identified from its co-
ordinates. For example the third cell down in the second column would be B3. 
This is called the cell reference.
 
 

Figure 3 Excel Window 
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3 Data Entry 

3.1 Entering Data 
Cell addresses are identified by the column letter and row number 
e.g. A1. Ranges of cells are separated by a colon (:) – e.g. B2:C5 is 
a block of cells.  

Exercise 4 Entering Data 
• Select the cell D1 by clicking in it once and type Magpies.  
• Enter the data into the cell by pressing the Enter key. 
• Type the following list of numbers shown right in cells D2 in cells 

D2 through D32, pressing the enter key after each number to 
move to the cell below.  

 
If you find that you have left out a row or column when entering your 
data you can insert new rows and columns.  

3.2 Inserting rows and columns 

Exercise 5 Insert a column 
• Click at the top of column A. 
• From the Insert menu choose Columns.  
 
A new column is inserted labelled A and the old columns A, B, etc. 
are renamed B, C etc. 

3.3 Autofill 
You can speed up data entry by using a feature called Autofill, 
sometimes called Autocomplete. Microsoft Excel 2003 can calculate 
data series such as dates, numeric series, days of the week.  
 

Exercise 6 Autofill data 
• Select cell A1 and type Date then enter the data into the cell (by 

pressing the enter key) 
• Select cell A2 and type 01/10/2004 then enter the data into the cell. 
• Click in cell A2 to re-select it, then move the mouse pointer to the bottom 

right corner of the cell until it turns to a fill handle (see below). 
 
 
 
 
 
 

Fill handle 

• Drag the fill handle down and you will see a series of dates appearing. 
Drag the fill handle until you have completed the series from 01/10/2004 to 
31/10/2004 (do not worry if you cannot complete it all in one drag, you can 
drag the last value as many times as you need). 
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3.4 Changing Column widths 
Sometimes your data will not fit into a cell. If a number is too wide for the cell it 
appears as hash signs ####. Text will appear to overlap into the next cell. 
Sometimes it will be sufficient just to adjust the column width by dragging the 
column headers to left or right. To do this 

 Move the mouse pointer to the edge of the column header (labelled A, B 
etc.) that you want to move. The pointer will change to I  

 Hold down the left mouse button and drag the column headers to the size 
that you want. 

 

4 Functions and Formulae 

4.1 What is a formula? 
A formula is a sequence of values, cell references, functions, or operators that 
are entered into a cell to produce a new value. A formula always starts with an 
= sign. 

 Values have already been introduced – in exercise Exercise 4 you entered 
the observed values for the number of magpies. Values are numeric data, 
for example measured values from an experiment, observed values, 
amounts of money. In survey analysis the replies are usually coded to 
have a value. For example in CCS workshop evaluations we rate a 
workshop with a score of 5 for ‘very useful’ through to 1 for ‘not much use’ 

 Operators are symbols such as arithmetic and logical symbols that you 
use to combine values. The most commonly used operators are the 
arithmetic operators are 

+ Add 
- Subtract 
* Multiply 
/ Divide 

 
 When you need to build a formula for yourself you can find a full list of 

operators in the Microsoft Excel 2003 online help index. You need to be 
aware of the order in which Microsoft Excel performs operations in 
formulas, known as the order of precedence of operators. Again this 
information is available to you on-line through the online help index.  

 To get help 
o Click on the ? symbol on the toolbar 
o Type the search term in the Search for  box. (for example 

‘arithmetic operators’) 
o Click on the arrow to the right of the box 
o From the list of results click on the one that looks most useful (For 

example ‘About calculation operators’  
 We will consider functions and cell references in the following sections. 

4.2 What is a function? 
Functions are predefined formulas that perform calculations by using specific 
values, called arguments, in a particular order, or structure. For example, the 
SUM function adds values or ranges of cells. 
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Arguments can be numbers, text, logical values such as TRUE or FALSE, 
arrays, error values such as #N/A, or cell references. The argument you 
designate must produce a valid value for that argument. Arguments can also 
be constants, formulas, or other functions. 
 
The syntax of a function begins with the function name, followed by an 
opening parenthesis, the arguments for the function separated by commas, 
and a closing parenthesis. If the function starts a formula, type an equal sign 
(=) before the function name.  
 
You can enter a function into a cell either by typing the function into the 
cell or by using the autosum button (see right) on the tool bar. Click on 
the dropdown arrow on the right of the button to see a menu of other 
commonly used functions. 
 
In the following examples we will look at two common functions SUM and 
AVERAGE (or mean value). Microsoft Excel 2003 also provides online help 
for many other functions. 
 

 You can stop the Office Assistant appearing when you choose Microsoft 
Excel Help from the Help menu. When the OA appears, click on options, clear 
the checkbox labelled Use Office Assistant is clear, and click on O.K 

4.3 Calculate the total for first row of data 
 If you cannot see any of the toolbar buttons referred to in this document 

choose toolbars from the view menu. There should be a tick mark next to 
standard and formatting toolbars. If there is not click on the toolbar to switch it 
on. 
 

 If you hold the mouse button over a toolbar button (do not click) a yellow 
label drops down to tell you the function of the button. This is called 
‘hoverhelp’ 
 

Exercise 7 Total data in a row 
• Enter the column title Totals in cell F1 
• Select cell F2 
• Click on the autosum button on the toolbar. As you have a series of 

numbers in cells B2:E2 Microsoft Excel 2003 works out that this is what 
you want to sum, and places the formula in cell F2 (see below). 

 

 
 
• Enter the formula into the cell by pressing the Enter key 
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 So far you have terminated edits by pressing the Enter Key. However there 
is an alternative technique. If you reselect cell F2 you will see the formula that 
you have just entered. You can edit a formula by clicking in the formula bar 
and typing the new formula. You can use the cursor keys to move left and 
right and the backspace and delete keys to delete characters. As an 
alternative to entering the data in the cell by pressing the Enter key you can 
enter the data by clicking on the tick mark next to the formula. 
 

4.4 Use autofill to copy the formula down column 
As well as using Autofill to copy data in a series you can use it to copy 
formulae. If you cannot remember how to do this please refer back to Exercise 
6. 
 

Exercise 8 Autofill a function 
• Use the autofill handle to copy the formula in cell F2 into cells F3:F32 
 
You should see that Microsoft Excel 2003 has incremented the row number – 
so cell F3 contains the formula =SUM(B3:E3) etc. 
 

4.5 Calculate A Total 
As well as using Autosum to sum rows you can use it to sum columns. If you 
cannot remember how to do this please refer back to Exercise 7. 
 

Exercise 9 Autosum a column 
• Use the Autosum button to calculate the total number of birds seen in the 

month in cell F33 

4.6 Calculate a Mean 
We will use the Function Menu that you can access from the autosum button  
to calculate the AVERAGE (or MEAN) number of birds that appear each day.  
 

Exercise 10 Calculate A Mean 
• Select cell B33 and click on the drop down arrow 

on the right of the autosum button on the toolbar  
• A function wizard menu appears, where you can 

select some of the more common functions from a 
menu. (see right). 

• Select Average  from the menu. 
• Note that Microsoft Excel 2003 has put the formula 

=Average(B2:B32)  in already (see right). 
However, this is not the formula that we want, as 
column B contains the number of sparrows 
each day. We want to calculate the mean of 
the total number, which is in column F. Click 
in the formula bar and replace the formula in 
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the box by the range F2:F32 and press the Enter key.  
If the function that you need is not on the drop down menu then you can 
select More Functions from the drop down list. The Insert Function box 
appears (Figure 4) 
 

Figure 4 Choose a function 
 

 
 
When you have chosen the function that you need Microsoft Excel 2003 will 
ask you for the arguments. You can type in a cell range or select it by 
dragging the mouse pointer over the range of cells on your spread sheet. 
 

Figure 5 Choose Arguments 
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4.7 Relative and Absolute References 
In Exercise 8 you used relative cell references, which are references to cells 
relative to the position of the formula. However, for some tasks you will need 
to use absolute references, which are cell references that always refer to cells 
in a specific location. For example, if we want to calculate the percentage of 
the monthly total of birds that appear each day we need to divide the daily 
total by the calculated monthly total. To calculate percentages in column G we 
divide each of the values in column F by the total value in F33 to get the daily 
percentage. If we do as we did in Exercise 7 and Exercise 8, i.e. calculate the 
first value in cell G2 & then autofill the column, we will not get the correct 
result.  F33 is a relative address and will change to F34 etc. We need to 
specify that the row number is an absolute address by putting a dollar sign in 
front of the row number i.e. F$33 
  

If a dollar sign precedes the letter and/or number, such as $A$1, the 
column and/or row reference is absolute.  
 

 Relative references automatically adjust when you copy them, and 
absolute references do not. 
 

Exercise 11 Absolute addresses 
• Enter the column title Monthly % in cell G1 
• Enter the formula =F2/F$33 in cell G2 
• Use autofill to copy the formula into cells G3 through G32 
• Select the data that you have just entered in cells G2:G32 then 

click the % button (see right) on the tool bar to format as 
percentages.  (If you cannot see the button on the toolbar click >> to see 
more) 

4.8 Labelling your calculations 
We calculated the total number of birds in the month, putting the result in cell 
F33. However, another person reading the spreadsheet would not know what 
this figure was so we will put a label next to the cell to tell others (and remind 
ourselves). We will use the wrap text feature to fit the label into the cell width.  
 

Exercise 12 Add and format a label  
• Enter the text data Total No of birds in month into cell E33. The text 

string is too long to fit the cell. 
• Reselect cell E33 and choose Cells from the Format menu. 
• In the Format Cells dialogue box select the Alignment tab by clicking on 

it. 
• Put a tick (also called a checkmark) in the box labelled wrap text 
• Close the dialogue box by clicking on the O.K button. 
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5 Drawing a graph 
There are many functions associated with Microsoft Excel 2003 to help you 
draw graphs. In this session you will only do some very basic work. You 
should take time to work with this powerful software and explore what you can 
actually do with it. It will stand you in good stead in the future. 
 
You will use chart wizard to draw graphs of your data. It is fairly 
straightforward and all you have to do is follow the instructions. You will find it 
easiest if you highlight the data you want to graph before you start. 
 

5.1 Creating a chart 
 Select the data that you want to plot. To do this highlight the cells 

containing the numbers you want to plot. If the rows or columns that you 
want to select are not adjacent then select the first row or column, hold 
down the Ctrl key and select the other rows or columns. 

 Start the chart wizard. To do this either left click on the chart wizard 
button on the toolbar (see right) or left click on insert and then chart 
on the pulldown menu.  

 This will start a series of dialogue boxes. The first is called: 
Step 1 of 4 Chart Type 
The first box should open on one labelled standard types. If it does not, 
click on the tab at the top labelled standard types. 
You will see a list of graph types. Choose a chart type from the list, and 
then choose a sub-type. You can view a description of the sub-types by 
selecting the subtype. You can preview how your graph will appear by 
clicking on the button labelled Press and Hold. When you have selected 
the chart type click next at the bottom of the dialogue box. 

  This takes you to Step 2 of 4 Chart Source Data. You should see a 
picture of your graph in the next dialogue box and the data range filled in 
the box beneath the picture. If you did not highlight your data, there will be 
no information in the data range box and you need to fill this in. The 
easiest way to do this is to click on the button at the right end of the box 
(the one with the red arrow) to move back to the data sheet. You can then 
highlight the data you want to plot. Click on the datasheet button (the one 
with the red arrow) to return to the dialogue box. The software should also 
have automatically detected whether your data is in rows or columns. The 
selected option will be indicated by a  If it has got it wrong - click in the 
appropriate circle. Then click on next to move to the next dialogue box.  

 This is Step 3 of 4 Chart Options. This is where you make your graph 
look pretty. It normally opens with titles tab at the front. Here you can 
enter the title for your graph and the labels for you axes. Do not forget the 
units. Some options: 

Click the gridlines tab and you can add or remove gridlines. 
Click the legend tab then you can position the legend or remove it 
completely. You do not need a legend in this session. 

Once you have finished, click on next, this will take you to the final 
screen.  
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 Step 4 of 4 Chart Location In this box - the program wants to know if you 
want the graph in the worksheet or on a separate page. Personally I find it 
easier to put them on a separate page so normally I click 'on separate 
sheet'. Finally click finish and your graph should be created. 

5.2 Changing the graph 
 Object is the term used by Microsoft to describe the various parts of your 

graph, e.g. the background, the axis, the data series. You may come across 
this term when referring to on-line help or reference documents.  
 

 You can find out what an object is called by moving the mouse pointer 
over the object (do not click). A small yellow label will drop down, showing a 
description of the object. 
 

 Sometimes you need to select an object that is part of another object. For 
example, you may want to select a data point that is part of a data series. The 
first click selects the data series. A slight pause (to avoid double click) and 
another click and you select a data point. 
 
If you want to change any aspect of the graph all you need do is to select the 
object that you want to change. To do this: 

 Either double click on the object you want to change - e.g. an axis or the 
background of the chart 

 Or right click on the object. This will give you a pull down menu that gives 
you a further list of options. 

5.3 Changing the background 
I prefer clear backgrounds to my graphs and, as you will find, the default is 
grey. You can change this by selecting the background object and double 
clicking on the background of the graph. A format plot area dialogue box 
opens. You can change the borders to none and the area to none. 

5.4 Formatting the Axes 
When using a black and white printer it is better to format the axes in patterns 
because it helps to make different series stand out when you have more than 
one series of Y values. To format the axes you must first select the axis object 
then use either right click or double click to bring up the dialogue boxes. 

5.5 To move bars together 
The bars on a histogram should be adjacent. If they are not, right click on one 
of the bars. A menu appears containing the option format data series. Left 
click on this and a dialogue box opens. Select the options tab and change the 
gap width to 0. You can set numeric values either by typing the number 
directly or by scrolling through the box using the scroll arrows. Click on OK to 
return to the graph. The bars should move together. 
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5.6 Histograms 
A histogram is called a column chart in Microsoft Excel 2003. It shows data 
changes over a period of time or illustrates comparisons among items. 
Categories are organized horizontally, values vertically, to emphasize 
variation over time. We will plot a histogram that shows how the total number 
of birds varies throughout the month. 

Exercise 13 Plot a histogram 
• Select cells A1:A32. 
• Hold down the Ctrl key and select cells F1:F32.  
• Start the Chart Wizard 
• In Step 1 of 4 choose chart type Column then choose sub-type Clustered 

Column. Click on Next> 
• In Step 2 of 4 check that you have selected the correct data range, which 

should appear as =Sheet1!$A$1:$A$32,Sheet1!$F$1:$F$32. Note the 
use of $ to indicate absolute addresses and the Sheet1! Qualifier to say 
that the data is on sheet 1. Check that Microsoft Excel 2003 has correctly 
worked out that the data is in columns. Click on Next>. 

• In Step 3 of 4 set the title to Birds in October. Label your X axis as Date 
and your Y axis as Total No of Birds. Clear the legend by clicking on the 
legend tab and clearing the show legend box. Click on Next> 

• In Step 4 of 4 choose As New Sheet and type the name OctoberTotals in 
the box next to it. Click on Finish 

 
You should now have a chart to format. In the next exercise you will select 
objects and format your chart. We will practice using both the double click and 
right click techniques to select objects so that you can see which you prefer. 
However, if you find double click difficult you can use right click. 
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Exercise 14 Format a chart 
• Double click on the background (called the Plot Area in Microsoft Excel 

2003 ). In the dialogue box choose a white backgound and click on OK 
•  Right click on the data series and choose Format Data Series from the 

pop up menu. Make sure the Patterns tab is selected. Click on the Fill 
Effects and choose a suitable fill effect, foreground and background 
colours. Click on OK to return to the Format Data Series dialogue. 

• In the Format Data Series dialogue box click on the Options Tab and set 
the Gap Width to 0 Click on OK.  

 
Your graph should now look something like Figure 6 
 

Figure 6 Histogram of Totals 
 

 
 

5.7 Scatter graphs 
An xy (scatter) chart either shows the relationships among the numeric values 
in several data series or plots two groups of numbers as one series of xy 
coordinates. This chart can be used for uneven intervals — or clusters — of 
data and is commonly used for scientific data. One of the most common 
things used on the x axis is time, for example readings taken at intervals 
which may or may not be regular. 
 
When you arrange your data, place x values in one row or column, and then 
enter corresponding y values in the adjacent rows or columns. 
 
In the next exercise we will draw a scatter chart to show how the number of 
birds of different species varies throughout the month. 
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In the previous exercise you only plotted one series (the totals) so there was 
no need for a legend to identify what the series meant. However, in the next 
example you will need the legend to distinguish between the different series. 

Exercise 15 Draw a scatter chart 
• Click on Sheet1 to go back to your data sheet. 
• Select the data in cells A1:E32. Note that because the data is in adjacent 

columns that you do not need to hold down the Ctrl key when selecting the 
data. 

• Start the Chart Wizard  
• In Step 1 of 4 choose chart type XY (Scatter) and choose the first subtype 
• In Step 3 of 4 give your chart the title Bird Species and label the X axis 

with Date and the Y axis with No of birds 
• In Step 4 of 4 save your chart as a New Sheet called SpeciesChart 

6 Saving your work 
Do not forget to save your file when you have finished. If you need to copy 
your files to a floppy disk we recommend that you proceed as follows: 

 Save it to your N:\My Documents folder 
 Close the file 
 Go to Windows Explorer and select the file in your N:\My Documents 

folder 
 Right click on the file, then select Send To from the popup menu. 
 Select 3.5” floppy 
 Make sure that the light on the floppy disk drive is not active before you 

remove the disk from the drive. 
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